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Overview 

General Information 

The South Dakota Department of Transportation (SDDOT) Electronic Bid System - Bidding Program is used 

for bid preparation and bid submission. Prime Bidders for a South Dakota Department of Transportation 
project will use this program to prepare and submit their bid. The South Dakota Electronic Bid System 
(SouthDakota-EBS) can be downloaded from the SDDOT Website and installed on a PC or laptop of Prime 
Bidders. It may also be used by those not bidding prime (subcontractors, DBE’s or suppliers) to see the bid 
items and prepare quotes for Prime Bidders. 

Software: 

SouthDakota-EBS performs all arithmetic, automatically calculates price times quantity extensions, 
subtotals by project detail and totals the bid. The program will check for an incomplete bid (failure to bid all 
required items) and it will not allow the contractor to bid more than one opposing alternate. For items which 
have fixed unit bid prices, the program will not allow the price to be edited. 

 
The Bidding Contractor initially installs SouthDakota-EBS on their computer following the download 
instructions available on the SDDOT Website. The SDDOT Website will always have the most current version 
of the installation instructions. It is important to note the program must not be installed on a server because of 
licensing restrictions. 

Project Items: 

After installation of SouthDakota-EBS on the Bidder’s computer, the Bidder may then go to the SDDOT 
Website to download a project item data file for any project open for bid. The project item data file contains 
the items, quantities, and project information for bidding of the project. The Bidder will then be able to open 
the downloaded project data file to prepare and submit a bid from their computer using SouthDakota-EBS. 
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Certified DBE Contractors: 

Some projects may require a Disadvantaged Business Enterprise (DBE) Commitment to be included with the 
bid. A data file of currently certified DBE contractors is available on SDDOT’s website which can be 
downloaded into SouthDakota-EBS for use in preparing the required DBE Commitment and/or Good Faith 
effort documentation. 

 
If you intend to sublet project items to DBEs, the software will assist you in the preparation of the required 
documentation to be submitted with your bid. 

Bid Submission: 

SouthDakota-EBS will create an encrypted bid file which must be submitted via the SDDOT Secure 
Bid Submission website.  Bid Submission Instructions are available on the SDDOT website. 
 

System Requirements 

The minimum recommended requirements to run SouthDakota-EBS are: Hardware: 

Pentium Processor with 64 MB of RAM and Printer 

Software: Windows Vista, Windows 7, Windows 8 or Windows 10 

Internet connection 

Web browser 

Requirements for electronic bid submission: 

Contractor ID. 

Bidder ID and password 

Internet Explorer Version 7.0 or higher 
 

It is desirable to have E-mail software (e.g., Outlook, Outlook Express), but not a requirement. As you 
submit a bid electronically, messages will be presented to you. The messages will also be duplicated in 
an email from the SDDOT and sent to the Email address associated with your Bidder ID and company. It 
is your responsibility to notify SDDOT if you change your email address. 

Who to Contact 

If you have any questions or problems, please contact the following resources: 
 

Technical and Installation problems or questions with the SouthDakota-EBS software, Bidder ID, 
Contractor ID, password or bid submission problems or questions: 

 
Contact the SDDOT Bid Letting Office at (605) 773-3275 
Email Address:  DOTBids@state.sd.us 
Website: http://apps.sd.gov/hc65bidletting/ebssupportpage.aspx 

Starting the Program 

To run the SouthDakota-EBS software, double-click on the SouthDakota-EBS icon installed on the desktop. 

 

 
 

 
 

mailto:DOTBids@state.sd.us
mailto:DOTBids@state.sd.us
http://apps.sd.gov/hc65bidletting/ebssupportpage.aspx
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Each time the SouthDakota-EBS software is opened you will receive the following message: 
 

 
 

     Once downloads are complete you will receive the following message: 
 

 
 
If a contractor profile has not been previously defined to the SouthDakota-EBS software, a ‘No Contractor 
Profile Exists’ message will display. After replying OK to the message, your contractor information can be 
entered in the ‘Contractor Information’ Window (see the ‘Contractor Profile Definition and Use' and 
‘Contractor Profile Information' sections). 
 

 

Contractor Profile/Status of Work 

Contractor Profile Definition and Use 

The Contractor Profile contains information about the bidding contractor which must be included in each bid 
submitted in order to identify the bidder on an electronic bid file or to print company information on any 
Bid reports printed from the SouthDakota-EBS system. 

 
The profile information needs to be entered once and can be modified at any time. Each time a download and 
install of the SouthDakota-EBS software is done; the Contractor Profile information is re-accessed from the 
data in the installation directory (unless the directory is manually deleted prior to the re-install of the software). 
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If you have multiple offices preparing bids, use only the company information for the main location in each 
instance of the Contractor Profile information. Company information maintained by SDDOT is updated 
with Contractor Profile information each time a bid is submitted. 

 
Some contractors may be incorporated under different names and Federal Tax Ids, but may submit bids from 
the same central office. To accommodate this case, the contractor can add as many profiles as they require. 
Each profile, therefore, requires a unique Contractor ID number (see below). 

 
If only one profile is defined to the program, it is automatically associated with all bids created on the 
system. Contractor Profile associations are made either when the SouthDakota-EBS software is started 
(see the 
‘Starting the Program’ section) or prior to the load of project items into SouthDakota-EBS (see the ‘Load Project 
Items’ 

Section). The Contractor Profile information is needed to print on the Bid Reports, to be included in bids 
which are electronically submitted. 

 
To add or edit a Contractor Profile, see the ‘Contractor Profile Information’ section. 

Contractor Profile Information 

To add a Contractor Profile, click on the menu item Profile, and then select Add Profile/Status of Work from 
the drop-down list. Once the ‘Contractor Profile’ Window displays enter the Contractor ID Number in the new 
profile Contractor ID window. This number is assigned by SDDOT and it is imperative the number is obtained 
from SDDOT and entered correctly into your profile (NOTE: To obtain your contractor id, please register as 

a new contractor on our website http://apps.sd.gov/hc65bidletting/userregistration.aspx). In order to 

process a bid submitted electronically, the Contractor ID Number in your profile must exactly match your 
Contractor ID on SDDOT’s central database. 

 
To edit or view a Contractor Profile, click on the menu item Profile, and then select Edit Profile/Status of 

Work from the drop-down list (or click on the Profile icon on the tool bar). 

 

http://apps.sd.gov/applications/hc65c2c/BidLettingNET/userregistration.aspx)
http://apps.sd.gov/applications/hc65c2c/BidLettingNET/userregistration.aspx)
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If more than one profile has been entered, you may select the desired profile to view by clicking on the 
drop-down arrow of the Contractor ID list box window and then selecting the desired profile ID. 

 
The required information on the Contractor Profile tab is the Contractor ID (Note: The Contractor ID Number 
must be obtained from SDDOT and is unique based on the company name.), Name (prequalified name – 

you must be consistent in the use of the prequalified name), Address (street or P.O. Box), City, State, Zip, 
Phone, President’s name and Authorized Signature. If you have an email address, use the email field in your 
contractor profile to keep your email address current with SDDOT. Each time you submit a bid, profile 
information included with the bid will update the SDDOT database with the two following exceptions: 

 
(1) Contractor ID – this must match your company ID already on the SDDOT database 
(2) Prequalified Name – If you are prequalified, you must contact SDDOT Prequalification office to change 
your company name. If you are not prequalified, please contact SDDOT Project Development - Bid Letting 
Office to change your company name. 

Since the Authorized Prequalification amount is needed on the Status of Work Report, there is a field for 
Current Authorized Prequalification Amount. See the ‘Status of Work' section for more information about the 
‘Status of Work Under Contract’ tab. 

To submit a bid, the contractor must have a bid bond. On the Contractor Profile tab, there is a box where the 
contractor may enter an annual bid bond authorization code. This bond information should be entered only 
for annual bid bonds issued by Surety 2000 only. If the contractor is bonding by individual contract, the 
bond authorization code should be entered on the Transmit Bid window. If the contractor is using a bid 
bond issued by SurePath the bond code must be emailed to dotbids@state.sd.us prior to the 
designated bid opening time. The annual bid bond authorization code the contractor enters on the 

Contractor Profile tab will automatically be entered in the bond authorization code box on the ‘Transmit Bid’ 
window, but this field may be changed if the contractor has a bond for a specific contract. The contractor may 
also enter an Annual Bid Bond Expiration Date. This date will be for the contractors use as a reminder of when 
to renew their annual bid bond. This field is not required and is not submitted with the bid. 

 
Save the data by clicking the Save button. 

mailto:dotbids@state.sd.us
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Delete a Profile 

To delete a Contractor Profile, click on the menu item named  Profile, select the Contractor profile to be deleted, 
and then click the Delete button.  

Status of Work 

The Status of Work Under Contract information is required to be reported by bidding contractors. The 
Status of Work Under Contract information can be updated at any time in the ‘Contractor Information’ 
Window. This information will be sent along with the bid to SDDOT Project Development office. The 
contractor will need to update this information as work under contract by the contractor changes. 

 
To add Status of Work Under Contract information, click on the menu item Profile and then select ‘Select 

Contractor’, click on the ‘Status of Work Under Contract’.  Click in each of the cells to add the information then 
click the Save button. 

 
To edit Status of Work Under Contract information, click on the menu item Profile and then select Edit 
Profile/Status of Work from the drop-down list. Click in each of the cells to edit the information then click the Save 
button. 

 
To delete an entry, click on the row/column Delete button to delete the entry. 
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Bid Preparation 

Download A Project 

Project Files (Bid Item Lists) must be downloaded from the SouthDakota-EBS Lettings website at: 
http://apps.sd.gov/hc65bidletting/ebslettings1.aspx 

 
 

Once you have clicked the SouthDakota-EBS Lettings link, select the letting in which you are interested.  The 
following screen will show 

 
 

This page shows the item number, project number, type of work and other information. The Work Type is the 
prequalified work type of the project. Prime Bidders must be prequalified in the specified work type(s) for any 
bid at or above $200,000. The plan holder list link will show you who is planning to be a prime bidder, quoting, 

http://apps.sd.gov/hc65bidletting/ebslettings1.aspx


 

 

 
05/31/2016 11 

prime bidder and quoting or not bidding or quoting. The Special Provisions link is a .pdf file of any special 
provisions for the project. All sections of plans are then listed. The plan sets are in .pdf format and will be 
available for download and printing by the contractor. Printed plans will no longer be available by SDDOT. The 
only printed plans will be ten copies of the plans for the Contractor who is awarded the bid. 
 

To download the bid item files (for use with the SouthDakota-EBS application, click the Log In button to the right 
of the Notice of Highway Bid Lettings link. 

 

 
 

Enter your contractor id (provided by SDDOT Project Development Office) and password. Click the log in 
button and you will be taken to the following screen. 

 

 
 

Click the Edit button by each project in order to fill in how you plan to bid the project and contact information. 
Once you have edited a project, click the confirm button.  After editing all projects you are interested in, click 
the save button. You will be taken to the following page. 
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To download the project item file for use with the SouthDakota-EBS application, Right Click and select Save 
Target As from the pop up menu. 

 

 
 

The following save dialog box will show. Select a folder where you would like to save the file and click Save. 
You may want to create a new folder for each letting and label it the letting date. Then save the bid item lists in 
this folder.  NOTE:  There is a pre-created folder C:\SouthDakota-EBS\DownloadedBidFiles which is 
where the software will first look for the bid item lists when you “Load” a bid item list.  You can save the 
file to this folder if you like. 
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You will now be able to load the project file into the SouthDakota-EBS application (See Load Project Items). 
 
 

If there are any addenda for this project, they will show below the project item file. Click the ‘Click 
Addendum Receipt’ link for each addendum. 

 

 
 

For each of the above addenda, the contractor will need to click the Click Addendum Receipt link. This allows 
SDDOT to know the contractor is aware there is an addendum for the project. After clicking the Click Addendum 
Receipt link the contractor will be taken to the page with more information for a particular addendum. 
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If the addendum causes a change in quantity or if a bid item has been added or deleted, an addendum bid item 
file will be available for download by referring to the same steps followed for downloading the original project 
item file.  After the download of the original project item file, each addendum bid file will need to be loaded into 
the SouthDakota-EBS application in addenda order. If there are two addenda, make sure to load addendum 1 
first and then addendum 2. The addendum files will have an A and a number right before the 
.txt in the file name (i.e. Item 1-BRO 8043(06)_200512221400A1.txt).  Please refer to the ‘Load Project 

Addendum File” section of this user manual. 

Load Project Items 

Once the project items data file (project file) has been downloaded from SDDOT’s Website and saved on your 
computer, the next step is to load the project items into the SouthDakota-EBS software. Start the SouthDakota-
EBS software 

and choose Load New Project from the Project menu (or choose the Load button  from the tool bar). 

 

 
 

The project being loaded will be automatically associated with the Contractor Profile that was selected when 
the SouthDakota-EBS software was initially started (see Starting the Program). If only one Contractor Profile 
has been defined to the SouthDakota-EBS software, the project is always associated with that profile and a 
profile does not have to be selected when SouthDakota-EBS is started. If more than one profile has been 
defined and a different Contractor Profile is to be associated with the project to be loaded, select  Profile from 
the menu bar, Select Contractor from the drop-down menu, and then select the desired Contractor Profile 
from the 
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‘Select Contractor’ Window. 

 
After selecting  Load New Project, choose the project you want to load in the ‘Select Project File to Load’ 
Window and then click the Open button.  You should be loading the project item file you saved in the 
previous step (Download a Project). 

 

 
 

After the project is loaded, the project items will be displayed in the ‘Project Item Bid Detail’ Window and bid 
preparation can be started (see the ‘Prepare Bid’ section). 
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After the ‘Project Item Bid Detail’ Window is displayed, unit price information can be entered and the 
project data saved (see Preparing the Bid for more information). It is good to save your work often. 

 
If a project has already been loaded and is being reloaded again, a warning message will show asking you 
to delete the project and then load it. 

 

 

Open Project 

To access a project which has already been loaded, or to edit or continue preparing a bid, choose Project 
from the menu bar and Select Project from the drop-down menu (or click on the Select icon 
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on the tool bar).  
 

 
 
A window similar to the following window will display a list of all the projects currently loaded on the computer. 
 

 
 

To select a project, either click on the desired project or use the arrow keys to move the selection bar from 
project to project and press the enter key to select the project. After a project has been selected, the project will 
be opened and the ‘Project Item Bid Detail’ Window is displayed (see Prepare Bid for additional information). 

Prepare Bid 

After Load Project or  Select Project action is completed, the ‘Project Item Bid Detail’ Window is automatically 
displayed. If this window has been closed, it can be opened by choosing Project from the menu bar and then 

Project Item Bid Detail from the drop-down menu (or clicking on the Project Item Bid Detail icon on 

the tool bar). 
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To prepare the bid, it is only necessary to enter Unit Prices and either Number of days for A + B bidding, days 
for daily lane mile rental or block closure days, if applicable. The program will compute Unit Price * Quantity 
extensions, subtotal the bid by Project Detail, and total the bid. 

 
The color codes in the unit price field indicate the status of the price field. The unit price field will be white if no 
unit price had been entered and blue if a unit price has been entered. Some items in a SDDOT project have 
fixed prices (Flagging, for example). The fixed price items will be un-editable and displayed with green in the 
unit price field. 

 
In some projects there are alternate items. This means the project designers have given the bidders items 
they can choose between. Once a unit price has been entered for an alternate item, all the items which may 
have been designated as being part of the same alternate set must also have unit prices. All items that are 
part of the un-chosen alternate set or sets will be un-editable and colored magenta. If the bidder desires to 
change the choice of alternates, zeroing out the unit prices previously entered will make all alternates editable 
again. The following is an example of a project with alternate items: 
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Some projects are designated as "A plus B bidding" and will require the Contractor to bid a number of 
calendar days in which to complete the project. If a project is an "A plus B" project, the field Daily Road User 
Costs will be displayed and the Contractor must bid on a Number of Calendar Days in addition to the unit 

prices for the items in the contract for their bid to be complete. Daily Road User Costs is an estimate of the 
daily dollar-cost impact to the traveling public due to the construction. The Daily Road User Cost, which is 
estimated by SDDOT, is then multiplied by the Number of Calendar Days and added to the total bid (see 
below for a description of the usage of the number of calendar days). If the project is not an "A plus B" 
project, neither the Daily Road User Costs nor the Number of Calendar Days field will be displayed. The 

following is an example of an "A plus B" project which requires the number of calendar days to be specified: 
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In the above example, if the Contractor estimates it will take 180 days to substantially complete the project, 
the daily road user cost of $2,250.00 will be multiplied by 180 resulting in $405,000.00 being added to the cost 
of the project as the "B" portion. 

 
To quickly scan to see which bid items have not yet been priced and whether the number of calendar days 

have been entered on applicable projects, use the Bid Status Report by clicking on the Bid Status icon 

 on the tool bar or by selecting View Status Report from the Bid drop-down menu (see the Bid 

Status Report in the ‘Print Bid Report’ section for more information). 

 
To save changes made to the ‘Project Item Bid Detail’ Window, click the Save button. If any changes are not 

saved before exiting, the confirmation window below will be displayed. Select yes to save changes or no to 
exit without saving changes. 

Disadvantaged Business Enterprise (DBE) 

Please refer to the Special Provision for DBE Requirements (included in the contract proposal packet (special provisions) for the 

project you are bidding) for specific contract requirements. 
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DBE Commitment & DBE Utilization 

 PART A – RACE CONSCIOUS – DBE Commitment 

If a project has a Specified DBE Goal assigned, the contract is Race Conscious (i.e., when the ‘Project DBE 
Goal’ in the ‘Project Item Bid Detail’ Window contains a non-zero percentage).  When a Specified Goal is 
assigned to a contract a DBE Commitment must be created and included as part of your bid if you intend to 
use a DBE sub-contractor to perform a portion of the work on a project and/or supply materials for a project. 

 

 PART B – RACE NEUTRAL PARTICIPATION – DBE Utilization 

If the DBE goal indicates ‘Not Specified’ the contract is Race Neutral (i.e., when the ‘Project DBE Goal’ in the 
‘Project Item Bid Detail’ Window states ‘Not Specified).  When a contract indicates “Not Specified” bidders are 
encouraged to include their anticipated DBE Utilization as part of the bid if intending to use a DBE sub-
contractor to perform a portion of the work on a project and/or supply materials for a project. 

The following is shown as an example of where the DBE Goal is indicated within SouthDakota-EBS.  
For this particular project, there is a Specified DBE goal of 2%. 

 
 
Regardless of if the goal is ‘Specified’ or ‘Not Specified’, the same process should be followed to enter 
your DBE Commitment or Anticipated DBE Utilization. 
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CREATE DBE Commitment & DBE Utilization 

To create a DBE Commitment or DBE Utilization, the appropriate project must be open (choose 
Project from the menu bar and Select Project from the drop-down menu (or click on the Select 
Project icon on the tool bar). 

  

Make sure the project which is open is associated with the correct Contractor Profile. The Contractor 
Profile name and the project number are both displayed in the SouthDakota-EBS Window’s title bar. 

 
After the desired project is open, select DBE from the menu bar and either Part A – Race Conscious - 

DBE Commitment or Part B – Race Neutral – Anticipated Utilization from the drop-down menu (or click 

on the Commit – A  or on the Commit – B  on the tool bar).  
 

The ‘DBE Utilization’ Window will be available to create or to continue to build the project’s DBE 
Commitment or anticipated Utilization. 
 

 
Three steps are required to build a DBE Commitment or Anticipated Utilization. Note the three 
window tab descriptions on the above graphic: 

Step 1_ Select 

Step 2_Edit & Validate 

Step 3_Report 
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Step 1_Select 

By default, the ‘Select’ tab of the ‘DBE Utilization’ Window is active. From the ‘Approved 
Disadvantaged Business Enterprises’ Window on the left, select a DBE sub-contractor which will 
perform some of the contract work by clicking in the ‘Select’ checkbox next to a sub-contractor’s 
name. You can scroll through the list of contractors by using the scroll bar. If you do not see the 
contractor’s name which you are looking for, either the contractor is not certified by SDDOT or you do 
not have the latest certified DBE Contractors file from SDDOT (also see the ‘Download the Certified 
DBE Contractors ’ and ‘Load Certified DBE Contractors in EBS ’ sections). 

 
After selecting a sub-contractor, select the item or items to be assigned to that sub-contractor by 
clicking in the ‘Select’ checkbox next to the item or items in the window on the right. You can scroll 
through the list of items by using the scroll bar. Once an item has been selected for that sub-
contractor, the item will display in the window at the bottom. The following is an example where 
items have been selected for a sub-contractor: 
 

 
 
If you want to delete (or remove) a committed item from a sub-contractor, select the item in the 
window on the right of the ‘Select’ tab and click in the ‘Select’ checkbox to remove the check. 
Reply ‘Yes’ to the following message to delete the committed item from that sub-contractor or ‘No’ 
to cancel the delete process. 
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If you want to delete (or remove) a sub-contractor from the DBE Commitment, select the contractor in 
the window on the left of the ‘Select’ tab and click in the ‘Select’ checkbox to remove the check. 
Reply ‘Yes’ to the following message to delete the sub-contractor from the Commitment or ‘No’ to 
cancel the delete process. 
 

 

Step 2_Edit and Validate 

To edit or validate any item in the window at the bottom of the ‘Select’ tab, click on the ‘Edit & Validate’ tab. The 
following is an example of a Project’s ‘Edit & Validate’ tab window: 

 

 
For each DBE which displays in the window, only the DBE Total column can be changed. 



 

 

 
05/31/2016 25 

• ‘DBE Total’ - specify the dollar amount you will be paying the DBE Contractor 
for the work they will be performing. The amount cannot exceed the total bid 
amount. The default is $0.00. 

 
To validate the data, click on the Check and Validate button at the bottom of the window. If an item 
is in error or is incomplete, an appropriate error message will be issued. If the commitment passes 
the validation check, a successful Check Commitment message will display. Reply OK to continue. 

 

Step 3_ Report 

To view or create a report of the DBE Commitment or Anticipated Utilization, click on the ‘Report’ tab 
of the ‘DBE Utilization’ Window. A report similar to the following will display. Scroll through the report 

to review it or print it by clicking on the Printer icon on the tool bar of the Report tab. 

 

 
A DBE report can also be viewed and printed by selecting Transmit Bid from the menu bar (or click on 

the Transmit icon  on the tool bar). See the ‘Transmit Bid’ section for more information 

about viewing and printing reports. 
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Create 'Good Faith Effort' Documentation 

PART A – RACE CONSCIOUS – Good Faith Effort 

 
If a project has a numerical Disadvantaged Business Enterprise (DBE) Goal assigned, a DBE Commitment is 
Race Conscious (i.e., when the ‘Project DBE Goal’ in the ‘Project Item Bid Detail’ Window contains a non-zero 
percentage). However, if a DBE Commitment cannot be created or the required goal cannot be met, ‘Good 
Faith Effort’ (GFE) documentation must be provided to SDDOT by the low bidder. GFE documentation can be 
submitted after the letting as well. Please see the DBE Special Provision for more information. See the ‘DBE 
Commitment’ section for additional information about creating a DBE Commitment. 

 
Please refer to the project’s Special Provisions for more information about Disadvantaged Business Enterprise 
commitment and ‘Good Faith Effort’ documentation requirements. 
 

DBE Contact Log 

 

The following functions are provided in the SouthDakota-EBS software to create documentation to support a ‘Good 
Faith Effort’ to meet the assigned DBE goal: DBE Contact Log and Quote Comparison. 

 
Navigate to the ‘Good Faith Effort’ Documentation from the Menu Items ‘DBE’, ‘Part A – Race Conscious By 

DBE’ and then ‘Good Faith Effort Documentation’ or by the ‘GFE - A’ icon on your Toolbar. 

 

The ‘Good Faith Effort Documentation’ Window can be used to document DBE subcontractors you contacted 
in the process of your bid preparation. It allows you to select the DBE subcontractor name from a drop-down 
list and then indicate the date of contact, method of contact, result of the contact. You may also add comments 
to any contact record. The information entered into the ‘Good Faith Effort Documentation’ Window will be used 
to create the DBE Solicitation List Report and will be included as part of your electronic bid package. You also 
have the option to print a Good Faith Effort Documentation DBE Solicitation report. 

 
After the desired project is open, navigate to ‘Part A – Race Neutral – Good Faith Effort Documentation’ 

Window from either the Menu Items ‘DBE’, ‘Part A – Race Neutral’, and ‘Good Faith Effort Documentation’ or by 

the ‘GFE – A’ icon  on your Toolbar. 

 
Select the tab labeled ‘Step 1. DBE Contact’. Select a DBE sub-contractor which you are soliciting to perform 
some of the contract work by clicking in box under the ‘DBE’ column. You can scroll through the list of DBE 
contractors by clicking on the down arrow to the right of the box and using the scroll bar. If you do not see the DBE 
contractor’s name which you are looking for, either the contractor is not certified by SDDOT or you do not have the 
latest certified DBE Contractors file from SDDOT (also see the ‘Download the Certified DBE Contractors ’ and 
‘Load Certified DBE Contractors in EBS ’ sections).  

After selecting a sub-contractor, tab to the Contact Method column and select from the drop-down list.  Tab 
again and enter the Contact Date and one more tab to select the Contact Result. 
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You may also add comments appropriate for this contact.  

 
To Save the record, click the  Save Button on the bottom of the window. 

 

Each record represents one contact, so if you make more than one attempt to contact a DBE, you will enter 
a record on this window for each attempt. If DBE firms are not interested or not responding, the Contact Log 
is the tool for documenting this situation. 

 
To view the DBE Contact Log Report, click on the ‘Step 2 Reports’ tab. ( See DBE Contact Log Report 
section for more information.) 

DBE Contact Log Report 

 
To view or create the DBE Contact Log Report, click on the ‘Step 2. Reports ‘ tab. If information exists 

(See DBE Contact Log for more information), a report similar to the following will display. 
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Scroll through the report to review it or print it by clicking on the Print Button on the bottom of the Window. 

 
The information on the DBE Contact Log Report will be included as part of your bid packet. 

 
The DBE Contact Log Report can also be viewed and printed by selecting Transmit Bid from the menu bar 

(or click on the Transmit Bid icon on the tool bar). See the ‘Transmit Bid’ section for more 

information about viewing and printing reports. 

 

PART B – RACE Neutral – Good Faith Effort 

If the DBE goal indicates ‘Not Specified’ the contract is Race Neutral (i.e., when the ‘Project DBE Goal’ in the 
‘Project Item Bid Detail’ Window states ‘Not Specified).  When a contract indicates “Not Specified” bidders are 
encouraged to include their anticipated DBE Utilization as part of the bid if intending to use a DBE sub-
contractor to perform a portion of the work on a project and/or supply materials for a project. Although bidders 
are not required to furnish GFE documentation for ‘Not Specified’ contracts, the SDBES software allows 
bidders to document their efforts on the DBE contact log if desired. 

DBE Contact Log 

The ‘Good Faith Effort Documentation’ Window can be used to document DBE subcontractors you contacted 
in the process of your bid preparation. It allows you to select the DBE subcontractor name from a drop-down 
list and then indicate the date of contact, method of contact, result of the contact. You may also add comments 
to any contact record. The information entered into the ‘Good Faith Effort Documentation’ Window will be used 
to create the DBE Solicitation List Report and will be included as part of your electronic bid package. You also 
have the option to print a Good Faith Effort Documentation DBE Solicitation report. 
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After the desired project is open, navigate to ‘Part B – Race Neutral – Good Faith Effort Documentation’ 

Window from either the Menu Items ‘DBE’, ‘Part B – Race Neutral’, and ‘Good Faith Effort Documentation’ or by 

the ‘GFE – B’ icon  on your Toolbar. 

 
Select the tab labeled ‘Step 1. DBE Contact’. Select a DBE sub-contractor which you are soliciting to perform 
some of the contract work by clicking in box under the ‘DBE’ column. You can scroll through the list of DBE 
contractors by clicking on the down arrow to the right of the box and using the scroll bar. If you do not see the DBE 
contractor’s name which you are looking for, either the contractor is not certified by SDDOT or you do not have the 
latest certified DBE Contractors file from SDDOT (also see the ‘Download the Certified DBE Contractors ’ and 
‘Load Certified DBE Contractors in EBS ’ sections).  

After selecting a sub-contractor, tab to the Contact Method column and select from the drop-down list.  Tab 
again and enter the Contact Date and one more tab to select the Contact Result. 

 
 
You may also add comments appropriate for this contact. The Contact Nbr. is generated each time you add 
a record to this window. 

 
To Save the record, click the  Save Button on the bottom of the window. 

 

Each record represents one contact, so if you make more than one attempt to contact a DBE, you will enter 
a record on this window for each attempt. If DBE firms are not interested or not responding, the Contact Log 
is the tool for documenting this situation. 
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To view the DBE Contact Log Report, click on the ‘Step 2 Reports’ tab. ( See DBE Contact Log Report 
section for more information.) 

DBE Contact Log Report 

 
To view or create the DBE Contact Log Report, click on the ‘Step 2. Reports ‘ tab. If information exists 

(See DBE Contact Log for more information), a report similar to the following will display. 

 
Scroll through the report to review it or print it by clicking on the Print Button on the bottom of the Window. 

 
The information on the DBE Contact Log Report will be included as part of your bid packet. 

 
The DBE Contact Log Report can also be viewed and printed by selecting Transmit Bid from the menu bar 

(or click on the Transmit Bid icon on the tool bar). See the ‘Transmit Bid’ section for more 

information about viewing and printing reports. 

Bidders List 

Bidders List Overview 

Federal regulations mandates SDDOT create and maintain a bidders list as part of the DBE annual goal setting 
methodology. SDDOT’s Special Provision for Disadvantaged Business Enterprise, Section II requires all prime 
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bidders to submit a bidders list with their bid. The bidders list information consists of all bidders/quoters, 

including subcontractors, suppliers, or service providers who have submitted a bid to the prime contractor for 
the project. 

Creating a Bidders List 

To create a Bidders List, the appropriate project must be open (choose Project from the menu bar and 

Select Project from the drop-down menu or click on the Select icon on the tool bar.
 

 
Confirm the project open is associated with the correct Contractor Profile. The Contractor Profile name and 
the project number are both displayed in the SouthDakota-EBS Window’s title bar. After the desired project 

is open, select Bidders List from the menu bar and  Build Bidders List from the drop-down menu (or click the 

Build Bidders List icon on the toolbar).  

 
Upper Left Section: Select the subcontractors, suppliers and service providers who submitted a bid to the 
prime bidder from the ‘Subcontractors’ list by clicking in the select box to the right side of their name. 
 
Upper Right Section: After selecting the subcontractor, select the applicable items from the ‘Work Group 

Description’ by clicking in the box to the right of the item. 
 
Bottom Section: Compiles the "Bidders List" for the selected contractor/subcontractors and applicable 

items. 
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You can also print/view/edit the bidders list from the ‘Bid Submission and Check List’ window. Select, 

‘Transmit Bid’ from the menu or the transmit bid icon from the toolbar. 

Add Subcontractor 

If a subcontractor’s name does not appear in the "Bidders List ", "Good Faith" or "Intend to Sublet" windows for 
selection, use "Add Subcontractor". 

 
 

New subcontractors name will be available for selection in the "Bidders List" and "Good Faith" windows: 
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Bid Submission 

Obtaining  a  Bidder  ID  for  Submission  of  Bids 

 

Prime contractors are required to obtain a Company ID and password.  The Company ID and password 
enable a company to access necessary bidding files, view addenda and sign in to a plan holders list for any 
project of interest.  A Company ID & password can be obtained by submitting the necessary information at:  
http://apps.sd.gov/hc65bidletting/userregistration.aspx. 

 

In addition to a Company ID, a prime contractor must obtain Bidder ID(s) and Password(s) for individuals 
intending to submit bids on behalf of the company.  Bidder ID(s) & password(s) can be obtained by completing 
and mailing or hand delivering the following form - Bidding Authorization Form available at: 
http://apps.sd.gov/HC65C2C/EBS/BidAuthorizationForm.pdf  Please be certain the correct email addresses 
are listed on this form as they will be used to communicate the successful submission or withdrawal of a bid.  
Once this form is successfully completed and submitted, the Department will issue a Bidder ID and Password 
via email to the individual bidders.  The form must be received, by the Department, a minimum of 48 hours 
prior to a designated bid opening time in order for Bidder ID(s) and Password(s) to be assigned in advance of 
the letting. 

 

The Bidder ID and Password, together with the Company ID, will be needed to access the Department’s 
secure bid submittal site, which is the only means of submitting bids to the Department. 

http://apps.sd.gov/hc65bidletting/userregistration.aspx
http://apps.sd.gov/HC65C2C/EBS/BidAuthorizationForm.pdf
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Accessing the SDDOT Bid Submittal Site 

After obtaining a Company ID, and an associated Bidder ID & Password, the prime bidder is able to 
submit bids to the Department’s secure bid submission site at: 
http://apps.sd.gov/hc65bidletting/bidsubmittallogin.aspx 

 

The bid submission page requires three pieces of information for the secure submittal of bids: The Company 
ID, the Bidder ID for an authorized bidder of the company, and the individual password for the authorized 
bidder. 

 
The first time an authorized bidder logs into the bid submission page, the system will require the 
password to be changed with several criteria, as shown on the Change Password webpage: The 
password must: 

1. be at least 7 characters in length 

2. contain at least one uppercase letter 

3. contain at least one lowercase letter 

4. include at least one number 

It is recommended your ID is not used in your new password. 
 

Once access is gained to the secure bid submittal site, the contractor has the opportunity to upload bids, 
update bids, or delete previously submitted bids.  Specific Instructions for the Bid Submission page are 
available in this user manual (Submitting Bid – Step 3). 

Security of the Bidder ID 

The security of the bidder ID is only as secure as the individual who has received the ID & password, wishes it to 
be. It is the responsibility of the authorized bidder to keep their ID & password secure. If the password needs to 
be reset, the Department must be notified so the password can be reset. 

Submitting Bid – STEP 1(Bid Submission Checklist) 

 

When a bid has been prepared and is ready to be submitted to SDOT, select Transmit Bid from the 

menu bar (or click on the Transmit Bid icon on the tool bar) and a ‘Bid Submission Check 

List and Forms’ Window, similar to the following, will display. This window will allow you to view and 

optionally print the forms which are to be submitted with the bid. 

http://apps.sd.gov/hc65bidletting/bidsubmittallogin.aspx
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The ‘Bid Submission Check List and Forms’ Window contains several sections with various forms 
available for viewing and printing. The availability of the forms depends on the project being 
submitted for bid (e.g., DBE forms are only applicable for Federal Aid projects) or on other criteria 
(e.g., Status of Work Under Contract may not include information if no work was specified in the 
Contractor profile). See the ‘Print Forms’ section for more information about each form. 

PROPOSAL GUARANTY / BID BONDS 

In addition to viewing the forms which will be transmitted, the ‘Bid Submission Checklist and Forms 
Window’ is where bidders can verify and/or enter their proposal guaranty information.  The following 
outlines choices for submitting a proposal guaranty to the Department: 

Surety 2000:  

If Surety 2000 is selected the Bid Bond Authorization Field will automatically fill in the Annual Bid Bond code 
entered in the Contractor Profile Screen.  If nothing is entered in the contractor profile screen the field will 
be blank.  If you wish to enter a project specific bid bond code issued by Surety 2000 in lieu of an annual 
bid bond code the field is editable and may be overwritten with the project specific code. 

SurePath:   

If SurePath is selected the Bid Bond Authorization Field will automatically fill in the Annual Bid Bond code 
entered in the Contractor Profile Screen.  If nothing is entered in the contractor profile screen the field will 
be blank.  If you wish to enter a project specific bid bond code issued by SurePath in lieu of an annual bid 
bond code the field is editable and may be overwritten with the project specific code. 
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Paper Bond:   

If Paper Bond is selected a message will appear stating “Please mail in your original hardcopy to the SDDOT 
Bid Letting Office” and the Bid Bond Authorization Code field will automatically fill in with “Paper Bond1” 
which notifies Bid Letting staff at bid opening time that a paper bond is being used.  The hardcopy must be 
received by the Department (Office of Project Development – Bid Letting) prior to the designated bid opening 
time. 

Proposal Guaranty:   

The Proposal Guaranty should be selected if you will be submitting a Cashiers or Certified Check in lieu of a 
bond. 

Submitting Bid – STEP 2 (Creating your Bid Proposal File) 

Once you have reviewed the items on the Bid Submission Checklist and Forms page and are satisfied with the 
preparation of your bid, please select the Transmit Bid button located at the bottom of this page. 
 
If you have not included required information in your bid packet, you will be prompted to complete it prior to 
submission. Following are some examples of the messages: 

 

The above message would be displayed if the project has an assigned DBE goal and the DBE Commitment 
has not been provided. This message does not stop the bidder from submitting a bid. If you plan to include a 
DBE commitment, but have not, click on ‘No’ and add the commitment at this time. If you have included your 
DBE commitment, or do not have any commitment, click on the ’Yes’ button to continue processing. 

 

 

The above message would be displayed if the project has an assigned DBE goal and the DBE Commitment 
does not meet the assigned DBE goal. This message does not stop the bidder from submitting a bid. If you 
plan to include a DBE commitment, but have not, click on ‘No’ and add the commitment at this time. If you 
have included your DBE commitment, or do not have any commitment, click on the ’Yes’ button to continue 
processing. 

The contractor may want to send in the Good Faith Effort if they have completed it for bid submission in 

SouthDakota-EBS. In order to include the Good Faith Effort in the bid submission, click the Good Faith Reports 

checkbox before clicking the Transmit Bid button.  If this checkbox 
is blank, the Good Faith effort will not be submitted with the bid. 

 
After all of the warning messages have been displayed a ‘Save to File and for Bid Submission’ window, similar 
to the following, will display. Click on the Browse button to select where to save the bid submission file. Click 
the Save button to save the encrypted bid to the folder selected. The encrypted file for your records will be 
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saved with the filename of 00xxxx_00####_YYYMMDD.txt where 00XXX is the contract number set by 
SDDOT, 00#### is the Company ID, and YYYYMMDD is the bid letting date for the project. The bid file 
00xxxx_00####_YYYYMMDD.txt should not be confused with the bid download file which begins with Item #. 
 

 
 
If the bid has been saved successfully, a Bid Submission message similar to the following will display. Click 
on the OK button to continue processing. 

 
 
The SouthDakota-EBS software will open Internet Explorer on your computer and direct you to the SDDOT 
Secure Bid Submittal Site. You may see a security warning message similar to the one below. Click OK to 
proceed. 
 

 

 
 

Click ‘Ok’ to continue. 
 

Submitting Bid – STEP 3 (Secure Electronic Bid Submittal Site) 

The following log-in page will load: 
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Fill in the necessary information and click on ‘Log In’. 

The first time a new Bidder logs into the bid submission site, the website will take you to a webpage 
similar to: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Please note the criteria for your password, to help in making the password as secure as possible. The 
password must: 
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1. be at least 7 characters in length 

2. contain at least one uppercase letter 

3. contain at least one lowercase letter 

4. include at least one number 

It is recommended your ID is not used in your new password. Once the password has been accepted, 
you will be prompted to either ‘Continue to Bid Upload Page’, or ‘Log Out’. 

If you have previously changed your password, or if you select ‘Continue to Bid Upload Page’ after 
changing of the new password, you will be securely logged into the website. The bid submission page looks 
like: 

 
 

This site allows the contractor to submit, revise and withdraw bids for any current letting.  In addition, the site 
also allows you to “View Log” which keeps history of your bidding activity with the Department. After the time 
and date of letting, the files will no longer be accessible, and will become property of the SDDOT. 

 

Before submitting/Uploading a Bid, you must check the highlighted box above. 

Submitting / Uploading Your Bid 

 
To submit a bid, click on ‘Browse’ and proceed to the directory where the bid file 
(00XXXX_00####_YYYYMMDD.txt) was saved (see Encrypted Bid File Submission section above) and 
choose the appropriate file. 
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Click on ‘Open’, and the file will be selected in the ‘Select File To Upload’ window. 

 
 

Select ‘Upload Bid’. If the file selected is for a current letting, the website will indicate a successful 
submittal of the bid with a page similar to: 
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In addition, an email will be sent to the specific email registered with the Bidder ID utilized in submittal of the 
bid. 

 
Please note, the bid submission site will not allow submittal of bids which do not have the correct format, 
are being submitted for lettings which have passed, or are being submitted for a company other than the 
company who is currently logged into the bid submittal page. 

BID REVISIONS 

If you would like to submit a revised bid, the process is the same as submitting an original bid. Make the 
changes to the bid utilizing the SouthDakota-EBS, create a new encrypted bid file, and save the file to your own 
directory. Follow all the steps necessary as detailed in the Electronic Bid Submission to SDDOT section above. 
Re-submission of a bid file will overwrite the original file. The website will prompt you to accept for the overwrite. 
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The latest bid received prior to 10:00 A.M. on bid open day will be the only bid which will be opened for 
consideration. 

If you select ‘Overwrite File’, the previous file will be over-written and will no longer be available. Choosing 
‘Cancel’ will not allow for the overwriting of the file previously submitted. If you overwrite a file, you will receive 
an email to the specific email registered with the Bidder ID utilized in submittal of the bid which will indicate a 
bid has been overwritten. 

 

WITHDRAWAL OF A BID 

Bids may be withdrawn any time after bid submission, and prior to the date and time of the bid opening. After 
the bid opening time, the bid may no longer be withdrawn. To withdraw a bid, click on the checkbox by the 
‘Withdraw Bid’ at the bottom of the page: 

 
Once checked, the bottom of the webpage will open with the bid withdrawal options. 
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First select the letting date for the project which you wish to withdraw from the current lettings listed in the 
Letting Date box. 

 
After selecting a letting date, the Items for the letting will be presented in the item Number box. Highlight the 
item number for which the bid was previously submitted. Please note the list will include all items for the letting, 
whether a bid was previously submitted or not. After selecting the Item number, click the ‘Withdraw Bid’ button 
on the bottom of the page. 
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The system will provide a confirmation box, to ensure the correct item was selected. If the bid is to be 
withdrawn, select ‘OK’. A confirmation notice will appear on the bottom of the page. The system will also send a 
confirmation to the specific email registered with the Bidder ID utilized in withdrawal of the bid which will indicate 
a bid has been withdrawn. 

 
 

 
If a bid has not previously been submitted from your company for the project, the webpage will indicate that 
the file cannot be found: 

 

Viewing Log of Bid Activity 

 
Select the View Log button at the bottom of the screen to view history of your bidding activity with the 
Department. 
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Please contact SDDOT Bid Letting staff to report any issues with the log. 

Late Bid Submission 

If a bid submission is attempted after the 10:00 A.M. bid opening deadline for a project, the bid submittal page 
will not allow the submission of the file and will provide a message indicating the time of letting has expired. 

 
It is your responsibility to ensure the bid transmission is completed prior to 10:00 a.m. on bid open day. This 
means not started at 10:00, not in progress at 10:00, but transmission is completed prior to 10:00. Be sure to 
allow time for the completion of the transmission. Your Internet service provider could be a factor affecting 
the successful timely completion of an electronic bid transmission. If your connection is slow, you need to 
begin your upload sooner. If your connection is not reliable, you need to allow time to reconnect to the 
Internet and begin the transmission again. 

 
When the bid upload is completed successfully, you will be notified of the bid receipt time. The time must be 
prior to 10:00 A.M. 

Reports 

Print Bid Report 

To print the Bid Report, choose Bid from the menu bar and then choose Print Bid Report from the drop- down 

menu . Note: The project must be Open before the bid can be printed. The report can also be printed by 
choosing Transmit Bid from the menu bar (see the ‘Print Forms ’ section for more information). 

 
The Bid Report will have the project information, Contractor name, and Contractor ID printed in the 
heading of each page. 

 
If an item is a fixed price item, it will be indicated in the item description. 

 
Subtotals are printed for each section (a section is known as a "Project Detail"). If a project is an "A plus B 
Bidding" project, both the "A" and "B" portions are tabulated. If the bid is incomplete, the title "Bid is 
Incomplete" will print next to the total. When the bid is complete, the title "Total Bid" will print next to the 

total. 

 
The Signature Page follows the Project Items portion of the Bid Report. If the project is a Federal project 
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(i.e., a portion or all of the project is Federally funded), there will be a section for the Contractor to 

indicate if the source of steel on the project will be of domestic or foreign origin. The Authorized Signature line 
must be completed, as must the Receipt of Addenda section, if there have been Addenda to the project. 

 
It is important to note at the bottom of the Signature Page, there is a SDDOT Project Creation Date. This date 

will be an important reference in the case where a project design is changed by an Addendum. In which case, 
the SDDOT project data will be reissued and made available on the SDDOT Web Page. Contractors who 
have purchased plans previous to that Addendum and have installed the project data will need to 
reinstall the project data. A check of whether the correct project data was used to prepare the bid will be the 
SDDOT Project Creation Date. It is also necessary to complete the Receipt of Addenda block on the Signature 
Page with Date and Initials for each Addendum received on the project. 

 
If an incomplete bid is printed, the Bid Status Report will automatically be printed as well. 

Print Forms 

The SouthDakota-EBS Construction Project Bidding Program provides for printing of all the reports or forms 
prior to submission. The SouthDakota-EBS software allows for completing all required reports and forms, 
which need to be electronically submitted, including the Bid Bond or Proposal Guaranty. 

 
The ‘Bid Submission Check List and Forms' Window contains several sections with various forms or portions of 
forms available for viewing and printing. The availability of the forms depends on the project being submitted 
for bid (e.g., DBE participation forms are only applicable for Federal Aid projects) or on other criteria (e.g., 
Status of Work Under Contract may not be required depending on what was specified in the Contractor profile). 
If the form or item is to be included in the bid, the SouthDakota-EBS software will include it in the bid file. When 
the form, item, or report listed has a View button to its right, the button can be selected to view the form, a 
portion of the form which is affected by the item, or the report. 

 
If the form or report is being viewed, it can be printed by clicking the print button at the bottom of the window. 

 
Information on the forms must be added or updated through the menu items provided in SouthDakota-EBS. 
Update is not available from the View report function on the ‘Bid Submission Check List and Forms ‘ Window. 
If a report view does not include information or a report is missing from ‘Bid Submission Check List and Forms 

‘ Window, select the appropriate SouthDakota-EBS function from the menu bar, enter or update the required 
information and then return to the ‘Bid Submission Check List and Forms ‘ Window to view your bid reports. 

Export Project to Text File 

Export Project to Text File 

Many Contractors make use of spreadsheets or packaged software packages to assist in bid preparation. The 
Export Project to Text File feature exports a project, items, and bid information to an ASCII text 
format file which can be opened in a spreadsheet application, worked with there, and then the bid prices can 
be imported back into the Electronic Bid System (see the ‘Import Project from Text File’ section). The 
export/import option does work with Timberline Estimating software, HCSS or Bid2Win. 

 
It is very important to note the original columns of the data exported to text must not be moved (i.e., they 

must remain in the same sequence); and the file must be saved back to an ASCII text format in order for the 
import to be successful. Specifically, the sequence of columns must not be moved (i.e., their sequence must 
remain in the original sequence when the file was exported from SouthDakota-EBS) and, except for the 
column with the unit price, should not be edited. 

 
If using Excel, note the information is in tab-delimited ASCII format. 
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To Export data, Open the project to be exported, select  Project from the menu bar, and then Export Project 
to Text File from the drop-down menu. A window similar to the following will be displayed. Click on Cancel to 
discontinue the export; otherwise, click on Export to continue the export process. 

 

 

When the export is complete, the confirmation box below will be displayed. 

 

 
The Contractor can now open the text file using their spreadsheet program. To open the text file in 
Excel, use the following steps: 

1. Open Excel 

2. Open the text file which was saved above 

 

3. Make sure data type is set to Delimited, then click next 
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4. Make sure delimiters are set to Tab, then click next 
 

 
 

5. Scroll over to Bid Item Number column, click on column heading and select Text, then click 
finish 
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6. Update unit prices (Column P) 
 

 
 

7. Click Save and then click yes on the following message 
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8. Close EXCEL 
9.  Click Save on message which pops up 

 

 
 

10.  Click Yes on message which pops up 
 

 
 

 
11.  Click Project and select Import Project from Text File from drop down menu 

 

 
 

12.  Click OK 

 

 
 

13.  Select text file saved in Excel 
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14.  Click Open. Unit prices entered in Excel should now show up in the SouthDakota-EBS bid file. 
 

 

Import Project from Text File 

After calculations have been made in a spreadsheet program which the Contractor has chosen to use, the unit 
bid prices can be imported into the Electronic Bid System. It is important to note in the spreadsheet program 
columns must not be moved (i.e., their sequence must remain in the original sequence when the file was 

exported from SouthDakota-EBS) and, except for column with unit prices, should not be edited. 

 
The information must be converted back to a text file with the same format as the exported file. If the file 
layouts are not the same, the import will not work. 

 
To import data, choose Project from the menu bar, and then Import Project from Text File from the drop- down 

menu. 

 
The Import From … dialog box, similar to the following, will be displayed. Select the source of the data, and 
click Open to continue the import process; otherwise click Cancel to discontinue the import. 
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If the import is successful, the following message will appear. Click ‘OK’ to continue. If the import fails, a 

failure message will be displayed. 

 

Deleting Projects 

Deleting Projects 

Once a bid opening has taken place and the project has been awarded, you may want to delete the project. 
Select the project to be deleted from the ‘Select Project For Bidding’ screen by clicking the  

 icon in the far right ‘Delete’ column. 
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After clicking the delete button, a confirmation window, similar to below, will be displayed.  To delete the project 
press enter or click the ‘Yes’ button.  Click ‘No’ to cancel the deletion. 

 

 

Import/Export Total Project File 

Export Total Project File 

Many contractors may want to have parts of the bid for a project created on another machine. In order to 
allow the contractor to create the different parts on one machine and then connect it to the contract/project file 
they will be bidding on, the Export Total Project File and Import Total Project File options were created. To 
export the Total Project, the contractor will need to select a project and open it. Then the contractor will then 
select the Project Menu option and within, the Export Total Project File menu option. See example: 

 
 

To Export data, Open the project to be exported, select ‘ Project’ from the menu bar, and then Export Total 
Project File  from the drop-down. A window similar to the following will be displayed. Click on Cancel to 
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discontinue the export; otherwise, use the Browse button to find the folder in which you would like to export 
the file. Select the checkboxes of those items you would like to export, click on ‘Export’  to continue the export 
process.  
 

 
 

You will receive the following message (although the file name will change based on the project number). 

 

 

This file can then be imported back into the Electronic Bid System (see the ‘Import Total Project File’ 
section) on another machine. 

Import Total Project File 

After the file for Total Project File has been exported on one machine, the contractor may import the Total 
Project File to another machine.  The reason the contractor may want to do this is because one person may 
work on the different parts of a project on one machine, while another works on the estimate for bid on another 
machine. Instead of re-entering the information so all the information is on one machine, the contractor may 
choose to import the different parts. After completion of the export Total Project File, the file may be imported 
into the SouthDakota-EBS software on another machine. Both machines will need to have the project file. 

After moving the exported Total Project file to a folder (or disk) which may be shared by both machines, on the 
machine to import the file into the user may import the parts of the project. 

 
To import data, choose Project on the menu bar, and then Import Total Project File from the drop-down 
menu. 
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A dialog box, similar to the following, will be displayed. Select the source of the data, and click Open to continue the 

import process; otherwise click Cancel to discontinue the import. 

 

The contractor will see the following window. They can select which items to import. If the file has the 
selected items, the information will be imported. It is important to remember this machine must contain 
the project file itself. 
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After selecting which items to import, click the Import button. The contractor will see the following 

message. 

 

 

Load Project Addendum File 

Load Project Addendum File 

If an addendum is issued which causes a change in quantity or if a bid item has been added or deleted, an 
addendum bid item file will be available for download by referring to the same steps followed for downloading 
the original project item file.  After the download of the original project item file, each addendum bid file will 
need to be loaded into the SouthDakota-EBS application in addenda order. If there are two addenda, make 
sure to load addendum 1 first and then addendum 2. The addendum files will have an A and a number right 
before the .txt in the file name (i.e. Item 1-BRO 8043(06)_200512221400A1.txt). This menu option will allow 

the contractor to download the new items and make changes to existing items without losing any previously 
entered unit prices for the project. 

 

 
 
You will now see a file open dialog box. Select the file to load and click open. 
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The new project items will load into the software and open with the unit prices filled in. The following window 
will display showing what items changed and how. For example, if an item quantity was changed, the report 
will say ‘120E6200’  - Water for Granular Material – Quantity Change.  If an item was added, it will give the 
same message with Item Added. A deleted item will give the message – Item Deleted. 
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Project Addendum 

Initial of Project Addendum 

Once an addendum file is loaded, the contractor will need to initial the receipt of the addendum. This will be 
transmitted with the bid as proof of receipt of addendum. On the Project menu, select Initial Project 

Addendums or click the Addendum icon . 

 
 
The following window will open: 
 

 

Click ‘New” and enter your initials then click ‘Save’.  

The number of addendums from this screen will be transmitted with the bid. 

 


